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Introducé@o ao Desenvolvimento de aplicagdes baseadas em componentes usando a plataforma .Net

1 Introducéo

Este documento pretende introduzir os aspectos relacionados com o desenvolvimento de
solucBes em ambiente .net utilizando a ferramenta de desenvolvimento Visual Studio .net
2003.

Adicionalmente, o documento apresenta guides de trabalho para exemplificar a criacdo de

aplicacbes .net baseadas em componentes.

2 A Plataforma .net

A plaforma .net € um ambiente de execucdo, CLR (Common Language Runtime) (Figura 1)
e uma plataforma de desenvolvimento, base class library (Figura 2), i.e., conjunto de

classes base sobre a qual se desenvolve

NET Framework Class Library Support

Thread Support COM Marshaler
Type Checker Exception Manager

Security Engine Debugger

MSIL to Native Code Garbage
Compilers Manager Collection

Class Loader

Figural - CLR

As classes da biblioteca de classes base do .net estdo organizadas em namespaces’
(Figura 2). Um namespace € um “espac¢o de nomes”, ou seja, um contexto de identificacao
de tipos que permite organizar o codigo de forma estruturada (hierarquica) e agrupar
logicamente tipos (ex., classes) relacionadas. Por exemplo, todas as classes base para

comunicagbes via rede estdo dentro do namespace System._Net ou em namespaces

! Para ver um mapa com toda a hierarquia de namespaces da plataforma .net consultar o URL

http://msdn.microsoft.com/library/en-us/cpref/html/cpref start.asp.
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dentro desse em caso de especializacdo (ex., System.Net.Sockets). Os namespaces
ndo estdo relacionados com heranga nem com o0s assemblies (é possivel ter classes de um

mesmo namespace em assemblies diferentes).

Os namespaces sdo uma técnica de organizar o cédigo e evitar conflito de nomes. Por
exemplo, ao desenvolver aplicagbes web ou Windows é possivel criar paginas com
controlos do tipo text box, no entanto a classe que representa uma text box é diferente para
cada um dos tipos de aplicacdes. As classes podem ter o mesmo nome, ex. TextBox,
desde que estejam em namespaces diferentes, ex., System.Web.Ul e

System._Windows.Forms.

Web Services System.Web User Interface

System.WinForms

HtmiControls

WebControls

System.Drawing

Data/XML System.Data System.Xml

.NET Framework

Base Frameworks
Collections Runtime
Configuration InteropServices
Diagnostics Remoting
Globalization Serialization

Common Language Runtime

Figura 2 - namespaces existentes na plataforma .net

Para se referirem no cdédigo a uma classe devem utilizar o0 nome completo da classe
(incluindo o namespace) . Por exemplo:

System.String x = “ola mundo”;

System.Random r = new System.Random();

No entanto, para simplificar a codificacdo, € possivel indicar ao compilador que se deseja
utilizar classes de um determinado namespace, usando a directiva using (import em
visual basic.net), e dessa forma é possivel referir essas classes sem 0 nome completo. Por

exemplo:

using System;

10/66 (c) Paulo Sousa
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String x “ola mundo™;

Random r new Random();

Desta forma a escrita do cédigo fica mais simplificada.

Um outro conceito importante na plataforma .net é o conceito de assembly. Um assembly é
um bloco de distribui¢cdo binéria da aplicacdo (pode ser um executavel ou uma DLL), que
contém uma coleccgdo de tipos e de recursos (ex., imagens JPEG), é “versionavel”’, e ao

gual podem ser afectadas permissdes de seguranga no contexto .net.

A figura seguinte representa o processo de execucdo de um programa na plataforma .net.

EXE/DLL
(MSIL and
metadata)

Compiler #— Source
Code

N WA C[ass [Loader

Class
Libraries
(MSIL and JIT Compiler
metadata) , withioptional

Verification

Truste’ N ‘ Call to an

Managed iled

pre-JiTed —> \tive uncompile
‘ode only Code

Execution

Security Checks

Runtime Engine

A

Figura 3 - processo de compilacdo e execucdo em .NET

Os tipos de dados dividem-se em duas categorias:

e Value type: contém directamente os dados e nao pode ser null

(c) Paulo Sousa 11/66



Introducé@o ao Desenvolvimento de aplicagdes baseadas em componentes usando a plataforma .Net

e Reference type: contém referéncia para objecto e pode ser nul'l

int sp 20

String cp —1—»| ola

Figura 4 - exemplo de um value type e um reference type

Como a maior parte das variaveis dos programas .net sdo tipos de referéncia e ndo de

valor, é necessario ter alguns cuidados na atribuicdo e comparacédo de variaveis. Veja-se

por exemplo o seguinte extracto de céd

igo C#:

Pessoa pl = new Pessoa(“anténio™);

Pessoa p2;

p2 = pl;

p2.Nome = “jo&o”;
System_Console_WriteLine(*

pl.Nome :

{0}, pl.Nome);

Como as variaveis de classe séo referéncias, a atribuicdo ndo copia os objectos. Ambas as

variaveis referenciam o mesmo objecto, logo a ultima linha vai escrever no ecra:

pl.Nome : joao

e nao:

pl.Nome : antoénio

Na figura seguinte podemos ver graficamente aquilo que acabou de ser explicado:

Pessoa pl = new Pessoa(“antdnio™);

Pessoa p2;
p2 = pl;
p2.Nome = “joao”;

p2

[ F—"

- 1
antonio P

1)

Figura 5 - atribuicdo de referéncias

?

@)

jodo

12/66
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Um outro cuidado adicional tem a ver com os testes de igualdade entre variaveis. Como as
variaveis sao referéncias, o operador de igualdade2 € na realidade um teste de identidade,

ou seja, verifica se as duas variaveis referenciam o mesmo objecto.

Pessoa pl = new Pessoa(“anténio™);
Pessoa p2 = pl;

Pessoa p3 = new Pessoa(“anténio™);
Pessoa p4 = new Pessoa(“luisa”);

System.Console . WriteLine(“pl == p2
System.Console . WriteLine(“pl == p3
System.Console_WriteLine(*pl == p4

{0}, pl == p2);
{0}”, pl == p3);
{0}”, pl == p4);

O extracto de cédigo anterior produziria 0 seguinte contetudo:
pl == p2 : true
pl == p3 : false
pl == p4 : false

No entanto, em determinadas situacdes, 0 que o programador deseja é um teste de
igualdade de valor e ndo de identidade de objectos. Nessa situacédo teremos que definir
explicitamente um método para comparacgao por valor ou redefinir a seméntica do método

Equals() da nossa classe.

Supondo que a classe pessoa tem dois atributos (nome e data de nascimento) a

comparacao entre dois objectos Pessoa seria implementada da seguinte forma:

public override bool Equals(object o)

{
iT (0o is Pessoa)
{
if (this.nome == o.nome && this.dtNasc == o.dtNasc)
return true;
else
return false;
}
else
return false;
}

2 Em C#, além do operador de igualdade (i.e., ==) é possivel comparar dois objectos usando o
método Equals() definido na classe Object. Para mais informagdo ver

http://msdn.microsoft.com/library/en-us/cpref/html/frirfSystemObjectClassEqualsTopicl.asp?frame=true. De

notar, para os programadores Java, que em Java o operador == efectua um teste de identidade
enquanto o método equals() efectua um teste de igualdade. Em C#, tanto o operador == como o

método Equals() tém o mesmo comportamento semantico.

(c) Paulo Sousa 13/66
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Como foi dito anteriormente, em C#, o operador == e 0 método Equals() tém o mesmo
comportamento semantico. Assim sendo, ao redefinir um deles devemos também redefinir o

outro. Neste caso, deveria acrescentar-se a classe Pessoa o0 seguinte operador:

public static bool operator==(Pessoa pl, Pessoa p2)

{
it (p1 !'= null && p2 '= null)
if (pl.nome == p2.nome && pl.dtNasc == p2.dtNasc)
return true;
else
return false;
}
else
return (pl == null && p2 == null ? true : false);
}

De notar que segundo as regras para redefinicdo de operadores ao redefinir o operador ==
também deve ser redefinido o operador !=. Para mais informacdo ver

http://msdn.microsoft.com/library//en-us/csref/html/vcwlkoperatoroverloadingtutorial.asp.

3 AlLinguagem C#

3.1 Introducéao

Nova linguagem tendo por base o C/C++
o Também vai buscar inspiragdo ao Java ;-)
0 Mantém o investimento e know-how existente
e Codigo mais “limpo”
e Construcdes sintacticas especiais para tirar partido do framework
e Tudo séo objectos

¢ Ficheiros com extensao .cs

Declaracéo e definicdo de métodos no mesmo ficheiro

3.2 Tipos de dados e operadores

A tabela seguinte apresenta os diferentes tipos de dados existentes no C#.

14/66 (c) Paulo Sousa
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Tabela 1 — tipos de dados existentes no C#

Categoria Tipos existentes

Objectos object

alfanuméricos string, char

Inteiros com sinal | sbyte, short, int, long

Inteiros sem sinal | byte, ushort, uint, ulong

Virgula flutuante float, double, decimal

boleanos bool

o Estes tipos sao alias para os tipos definidos na framework
o0 Ex, int==System.Int32
o Tipos Enumerados definidos pelo utilizador
e Fortemente “tipados”
e Sem conversdo automatica para int
e Suportam operadores +, -, ++, --, &, |, ®, ~

e Pode-se definir tipo de dados base (byte, short, int, long)

enum Color : byte

{

Red = 1,

Green = 2,

Blue = 4,

Black = 0,

White = Red | Green | Blue
}

A tabela seguinte apresenta os operadores existentes em C# (sdo os mesmo do C++). Em

C# é possivel redefinir operadores.

Tabela 2 — operadores existentes em C#

Categoria Operadores

Atribuicéo =

(c) Paulo Sousa 15/66
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Relacionais | < <= > >= == 1=
Logicos && 11 !
Aritméticos | + - * / %

+= -= *= /= ++ -

3.3 Sintaxe
3.3.1 Constantes
e Pré-definidas (null, true, false)

e De utilizador:

const string Ver = “1.0b”;

3.3.2 Classes e namespaces

¢ Organizacao do cédigo dentro de classes

o Classes organizadas dentro de namespaces

namespace Demo

{
public class MyClass
{
}

}

3.3.3 Construtores

e Seguem as regras do C/C++
¢ Mesmo nome da classe
e Sem tipo de retorno

e Podem ter ou ndo argumentos

public class MyClass

{

public MyClassQ) { --- }
public MyClass(string title) { ... }

16/66 (c) Paulo Sousa
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3.3.4 Métodos

e Sintaxe semelhante ao C/C++
e Podem ser publicos ou privados

e Suporta overloading

public class MyHelloWorld

{
public void SayHello()
{---17
private void SetTitle(String Title)
{---17
private void SetTitle(String title, Color c)
{---17
}

3.3.5 Passagem de parametros

O C# suporta passagem de argumentos para um meétodo, por valor e por referéncia. Neste

ultimo caso, é possivel indicar se o pardmetro é apenas de saida - out - ou de entrada e

saida - ref.

// passagem por valor
public void funcl(int x)

{---}

// passagem por referéncia — apenas de saida
public void func2(out int x)

{---}

// passagem por referéncia — entrada e saida
public void func2(ref int x)

{---1}

3.3.6 Heranca

e Apenas existe heranga simples, ou seja, uma classe apenas pode derivar de outra.

public class MyClassBase

{

public void Func(Q)
{--- 7}

(c) Paulo Sousa 17/66
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public class MyClassDeriv : MyClassBase

{
}}-explicitamente indicar a ocultacdo do método da classe base
public new void Func(Q
{--- 2}

}

e Métodos ndo sdo virtuais por defeito

public class MyClassBase

{
// indicar explicitamente que o método é virtual
public virtual void Func(Q)

{---7

}

public class MyClassDeriv : MyClassBase

{

}}-indicar explicitamente a redefinicdo do método virtual da
classe base
public override void Func()
{---7
}

e Aceder aos métodos da classe base

public class MyClassDeriv : MyClassBase

{
ﬁ&ﬁlic override void Func()
{ base.Func(Q);
Y -

}

3.3.7 Propriedades

e Sintaxe alternativa para acesso a membros de dados da classe mas com as vantagens

dos métodos

public class Button : Control

{

// atributo privado da classe
private string caption;

// propriedade publica
public string Caption

18/66 (c) Paulo Sousa
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{

// acessor ou getter

get { return caption; }

// mutator ou setter

set { caption = value; Repaint(); }
}

3.3.8 Objectos

e criacdo de objectos

// definicado da classe
public class MyClass { ... }

// definicdo da variavel
MyClass obj;

// criacao do objecto
obj = new MyClass();

e aceder ao préprio objecto

// utilizacdo da pseudovariavel
this.title = “ADAV”;

3.3.9 Arrays

e Suportados ao nivel da biblioteca base de classes em System.Array

// declaracédo do vector
string[] vec;

// criacao do vector
vec = new string[10];

// numero de elementos pode ser dinamico
vec = new string[n];

3.3.10 Ciclos

// repeticado n vezes
for (int x = 0; 1 < vec.Length; i++)
Console_WriteLine(vec[i]);

// repeticdo condicional
int i = 0;

(c) Paulo Sousa 19/66



Introducé@o ao Desenvolvimento de aplicagdes baseadas em componentes usando a plataforma .Net

3.3.11

while (i < vec.Length)

{

}

Console_WriteLine(vec[i]);

i++;

// enumeracao
foreach (String x in vec)
Console.WriteLine(X);

Condicionais

// teste de deciséo
if (i < vec.Length)
Console_WriteLine(vec[i]);

else

Console . WriteLine(*“Erro!!11’);

// teste multiplo

switch (X)
{
case 1: ...; break;
case 2: ...; goto case 3; // fall trough explicito
case 3: ...; break;
default: ...; break;
}

3.3.12 Comentéarios em XML

e Suportados pelo Visual Studio .net

o Documentam o cédigo (classes e métodos)

class MinhaClasse

{

/77
177/
/77
77/
/77
/77
77/
77/
77/
/77
/77
/77

<summary>

Returns the attribute with the given name and
namespace</summary>

<param name='‘name’'>

The name of the attribute </param>

<param name=''ns''>

The namespace of the attribute, or null if
the attribute has no namespace</param>
<return>

The attribute value, or null if the attribute
does not exist</return>

<seealso cref=" ="GetAttr(string)"/>

public string GetAttr(string name, string ns) {

}
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4 Desenvolvimento utilizando o visual studio

4.1 IDE

O ambiente de desenvolvimento do visual studio (Figura 6) é uma evolucdo do visual studio

6, que permite geracdo de codigo nativo windows e .net, no qual é possivel criar solucdes®

multi-projecto (em que cada projecto pode ser numa linguagem de programacao distinta).

Permite a criacdo de diferentes tipos de projecto (ex., aplicagbes de linha de comando,

aplicacbes windows e aplicacdes web).

Editor/Browser

Toolbox \

Server
Explorer \

Task List

. BenefitsWebSite - Microsoft Yist

Object Browser

ual Basic.NET [design] - Wel orm1.aspx
.

olution

Start Page  WebFormi.aspx | Chject Brovser

ab] Button

35| LinkButton
=] ImageButton
A Hyperlink
[E8 oropponntist
(=4 ListBox

5 DataGrid

(5] Datalist
Repeater

¥ CheckBox
82 CheckBoxdist
£ RadioButtonList
@ RadioButton

] mage
)

onisin
using absolute (x and y) cor

0 Design | E HTML |

grid layaut mode,

and chjects wil be! ©
ates.

ment),

i & word pracessing docur
the DOCUMENT o FlowLayout.

’ ‘Benefitswebsicf' (1 ppfeck
& {3 Benefitswebsite
(31 References
] Assemblylnfo.vb
@) BenefitstebSite. wsdisco
&) Global.asax
] Styles.css

lorer

perties

WebForm1.aspx
c:netpublwwroot)

Full Path

vl | Descripti

scription
Ehck here b add a new bask,

Figura 6 - Visual Studio .net

4.2

“Ola Mundo” em Consola

Criar um novo projecto do tipo “Console Application” em C#

* Dynamic Help

% No visual studio, uma solucéo (solution) funciona como um espaco de trabalho no qual podem

existir varios projectos.

(c) Paulo Sousa

21/66



Introducé@o ao Desenvolvimento de aplicagdes baseadas em componentes usando a plataforma .Net

o

Mew Project

Project Types: Templates:

% g

+-_1 mpplication Architecture For NET Wizard ASP.MET Web

=3 Wisual C# Projects

[\

+-[_7 Visual C++ Projects
(£ Setup and Deployvment Projects
+- Other Projects  \J SERIEERN
(2 wisual Studio Solutions

& project For creating a cormmand-line application

ASP.MET
Mabile W, .,

Windows
Service

\ﬁ

Web Conkrol
Library

Ernplky Project .

Y

®] |

Tlame: | ConsoleApplicationl

FMore Ok |

Cancel

Help

Location: | CADocuments and Settingsipsousal My Dncuments'l,.ﬁ.ctiﬂ Browse, .,

Praoject will be created ab Cih, Ay DacumentsiAckividade LeckivalDisciplinas!ADaM Consaledpplicationd

Figura 7 — criar um projecto tipo consola em C#

O Visual Studio vai gerar uma solucdo com um projecto contendo varios ficheiros. No

ficheiro “classl.cs” existe j& uma classe definida com um método Main().
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" ConsoleApplication1 - Microsoft Visual C# .MET [design] - Class1.cs® E]@
Fle Edit Wew Project Build Debug Tools window  Help
Q- &- b Debug v o imot c B E R,
E %o s 8 icd] .
% Start Page Elassl.cs*| < I % || Solution Explorer - ConsoleApplicati,,, 3 X
5 |§I:Console.\\pphcationl.Classl j ||§.Main(string[] args) j = zl =
<
= using System; —1| A Solution ‘Consoleapplication!' (1 project)
) ;
=3 2| = @ﬂ ConsoleApplicationl
g -] namespace Consolelpplicationl 4 Eefa.rences
pp.ico
{
AssemblyInfo.cs
e J—j A <sumnar v %Classl ci
A/ Suwmary description for Classl. .

A7 </ summarye

] class Classl

{

= //f <sunmary>

/// The wain entry point for the application.
Jf5 < sunmmary>

+ [STAThread]
= static woid Main(string[] args)
{
I
/¢ TODO: Add code to start application here
[ " | @Bs[ZcEr[&c |2 s
o }
L ¥ Properties 2
' T -
« ;fJ|_ : =
= | E
Cutpuk 2 x
El
TaskList [E] Output | B} Find Results 1 % Index Results @ Search Results For adOpenstatic Propetties | @ Dynamic Help
Ready Ln 19 Col 1 ch1l NS

Figura 8 — cddigo gerado automaticamente para projectos consola em C#

Colocar na implementacéo do método Main() a seguinte linha de codigo.
System.Console_WriteLine('Ola mundo!™);

Compilar e testar.

Caso se queira criar novas classes no projecto deve-se “clicar” com o botdo do lado direito
do rato em cima do projecto, escolher a opcdo Add - Add Class e criar uma classe (Figura

9) ou escolher a opgéo File > Add New Item e escolher o template “Class” da categoria
“Local Project Itens” (Figura 9).

(c) Paulo Sousa 23/66



Introducé@o ao Desenvolvimento de aplicagdes baseadas em componentes usando a plataforma .Net

Add Hew Item - RevisoesO0

[ 9]
Categaries: Templates: B0
N
» Cros0 ramework, p— .
QU = Local Project Items =
* . Windows Form Class Component | =
(£ Rational XDE User Defined Class
i T -_
: Y e |[E]
o
Ilser Control Daka Faorm [Daka Set
Wizard
¢ [F “
=
®ML File *¥ML Schema Zode File
-

An empty class declaration

lame; Classz.cs|

Cpen Zancel Help

Figura 9 - adicionar uma nova classe a um projecto

No visual studio, o solution explorer permite visualizar a estrutura do projecto em termos de
ficheiros (Figura 10) enquanto o class explorer permite visualizar a estrutura do projecto em
termos de namespaces e classes (Figura 11).

Solution Explorer - Consoletpplica.., . X
ENR SRR
E Solution '"Consolefpplicationl’ (1 project)
- l’éﬁ[unsulenpplicatiunl

+- i) References

App.ico

E‘l AssemblyInfo.cs

1 Y

< B
@Bs.[BEc. | @c. @1 [dls.

Figura 10 - solution explorer
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Class Yiew - Consalefpplicationl o x

s 5 —
Fe = | T =~

- ¥iCansoleApplication] ;
-1 {} Consoleapplicationl

- gg Classi

+ &g Bases and Interfaces
E‘r[‘ raingskring[ 1

s Bl | @c A1 s

Figura 11 - class explorer

As classes criadas no Visual Studio pertencem sempre a um namespace. Por omissdo o
visual studio cria um namespace com 0 mesmo nome do projecto (que é também por
omissdo o nome do assembly a gerar), no entanto é possivel modificar 0 namespace para

novas classes nas propriedades do projecto (Figura 12).

ConsoleApplication1 Property Pages

| ] = |

=3 Common Properties S|
g General G&mblv Mame Cunsnle.ﬂpplicatiuD
Designer Defaults Cukput Tvpe Zonsole Application
References Path efault Namespace Consoledpplication
Build Events Startup CBTE
(23 Configuration Properties application Icon App.ico
Supparted Runtimes
S|
=

Wrapper Assembly Key File
Wrapper Assembly Key Name

Assembly Mame
The name of the oukput file that will hold assembly metadata (manifesk)

[ fout),

(] | Cancel | Help

Figura 12 - propriedades de um projecto no visual studio (1)
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Nos laboratérios do DEI, dard jeito criarem os projectos na vossa area de trabalho na rede,

mas dirigir o resultado de compilacdo para um directério temporario na maquina local. Para

isso podem alterar nas propriedades do projecto o “output path” (Figura 13).

¥ Sy
ConsoleApplication1 Property Pages
Configuration: |.ﬁ.ctive{Debug} ﬂ PlakForn: |.ﬁ.|:l:ive{.NET]| j Configuration Manager.. . |
(23 Common Properties =
= Configuration Properties Conditional Compilation Constan DEBIG; TRACE
4 Build! Optimize Cade False
Debugaing Check For Arithmetic Cverflow/L False
Advanced Allow Unsafe Code Blocks False
=
Warning Lewvel Warning level 4
Treak Warnings As Errors False
Suppress Specific Warnings
=
@jut Path I:uin'l,DeI:uugD
XML DO remhemeli

Generake Debugging Information True

Output Path
Specifies the location of the output Files For this project's configuration.

(] | Cancel | Help

Figura 13 - propriedades de um projecto no visual studio (2)

4.3 Exercicios de revisao de conceitos OO

1

Escreva em C# o codigo que define uma classe de objectos Pessoa que
representa pessoas. Considere atributos como ‘nome’, ‘data de nascimento’, Bl e
NIF. Implemente os métodos que julgar necessarios nao esquecendo que 0s
atributos séo privados a cada objecto. Escreva ainda um pequeno programa que

permita criar objectos desta classe.

Tal como no exercicio anterior, escreva em C# o codigo que define uma classe
de objectos Endereco que representa enderecos. Especifique os atributos

necessarios e implemente os métodos necessarios.

Usando as duas classes de objectos dos dois exercicios anteriores escreva
também em C# o cddigo que define uma classe de objectos Contacto que
representa contactos de pessoas. Nao se esqueca de incluir atributos como o

telefone. Reflicta sobre quais os atributos desta classe, bem como, quais os
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parametros aconselhaveis para cada um dos seus métodos a luz do conceito OO
de encapsulamento e do facto da linguagem usar tipos de referéncia e ndo tipos
de valor. Deve também escrever um pequeno programa que permita criar

objectos desta classe.

Implemente em C# uma classe de objectos que permita armazenar um conjunto
de referéncias a objectos Contacto. Internamente estes objectos sé&o
armazenados numa colecc¢ao do tipo System.Collections.ArrayList (procure
no help do Visual Studio informacdo sobre como utilizar esta classe). Esta classe

deve ter, além dos construtores necessarios, 0s seguintes métodos:
Add - adiciona um contacto a lista
AddAt - adiciona um contacto numa dada ordem
At - devolve o contacto numa dada posigéo

Find — devolve 0 1° contacto que encontra que possua a chave de
pesquisa desejava (decida que campo utilziar como chave de

pesquisa)..

Reflicta sobre quais os parametros aconselhaveis para cada um destes métodos
a luz do conceito OO de encapsulamento. Escreva um pequeno programa que
crie pelo menos um objecto desta classe, insira contactos e procure por um dado

contacto.

5 Guiao de trabalho: Componente para operacdes aritméticas

5.1

introducéo

Antes de avancar para o desenvolvimento de uma aplicacdo baseada em componentes em

.net convém relembrar o conceito de componente e verificar como é que tal pode ser

mapeado na tecnologia .net.

Segundo alguns autores, um componente é:

“A software package which offers service through interfaces

» 4

* Peter Herzum and Oliver Sims, “Business Components Factory: A Comprehensive Overview of

Component-Based Development for the Enterprise”, John Wiley & Sons, Incorporated, 1999.
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e “A coherent package of software artifacts that can be independently developed and
delivered as a unit and that can be composed, unchanged, with other components to

build something larger” °

e “A component is a unit of composition with contractually specified interfaces and
explicit context dependencies only. A software component can be deployed

independently and is subject to composition by third parties.” ®

De acordo com estas definicbes, um componente é uma unidade de distribuicao em
formato binario de codigo, que fornece servi¢cos através de um contrato bem definido
(i.e., uma interface). Por sua vez, uma interface € um conjunto coerente de métodos.
Por conjunto coerente entenda-se métodos relacionados com um mesmo servico e/ou
trabalhando com entidades de um mesmo dominio. Um componente € utilizado por terceiros
aos quais se da o nome de “cliente”, um cliente é uma aplicacdo ou outro componente

gue faz uso dos servicos de um componente.
Em .net para responder a estes requisitos temos (Tabela 3):

Tabela 3 - mapeamento entre requisitos para componentes e a tecnologia .net

Requisito Mapeamento .net

Unidade de distribuicdo binaria | Class library

Fornecimento de servicos Classes

Contrato explicito Interfaces

Reutilizacao Referéncia a class library
Composicao por terceiros Composicdo e especializacdo

(heranga) de classes

Para uma breve introducdo a estes conceitos aconselha-se a consulta do glossario
disponivel na Microsoft Developer Network Library’ em

http://msdn.microsoft.com/library/en-us/netstart/html/cpconGlossary.asp.

® D.F. D'Souza and A.C. Wills, “Objects, Components, And Frameworks with UML — The Catalysis
Approach” Addison-Wesley, 1998.

® C. Szyperski, “Component Software: Beyond Object-Oriented Programming” Addison-Wesley, 1998.

" MSDN : http://www.msdn.microsoft.com/library
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5.2 Solucéao

No visual studio, uma solugéo (solution) funciona como um espaco de trabalho no qual

podem existir varios projectos de diferentes tipos (executaveis, bibliotecas de classes, etc.)

para um

mesmo problema. Vamos entéo criar uma solugédo em branco (i.e., sem projectos),

usando a opc¢do de menu File > New - Blank solution .

-~

Mew Project

-

Project Tvpes: Templates:

Marmne:

Location:

~

+-[_1 Application architecture For JMET Wizard @

[ visual Basic Projects

[ wisual C# Projects

[ visual 14 Projects
+-[_ Visual C++ Projects

[C setup and Deployvment Projects
+-[_] Other Projects

3 Wisual Studio Solutions

Create an empky solution containing no projects

Solution will be created at i, A Actividade LectivalDisciplinas) a0aviExxemplogrtimeticatet,

FMare Ik | Zancel | Help |

Blank Solution

| Exernplofrtinmeticaklet

| CiiDocuments and Settingsipsousal My Du:ucuments'l,.ﬁ.ctij Browse. ..

* Close Solukion

Figura 14 — criar uma “solucdo” sem projectos iniciais

5.3 Class Library

A solugdo anterior adicionar um projecto para 0 nosso componente (Class Library) usando
File > New - Project.

NOTA:

Podem encontrar regras de codificacdo .net (ex., nomenclatura de classes) para

class libraries em http://msdn.microsoft.com/library/en-

us/cpgenref/html/cpconnetframeworkdesignguidelines.asp. Associado a este

conjunto de regras existe uma ferramenta intitulada FxCop (disponivel em

http://www.gotdotnet.com/team/fxcop/) que executa a validacdo de um assembly

.net no que toca as regras de codificacdo e algumas boas praticas.
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o

Mew Project

Project Types:

Templates:

+-[_7 application Architecture For MET Wizard
(L7 wisual Basic Projects
5] Wisual C# Projects
(L wisual 1# Projects
+-[_7 wisual C++ Projects
[C3] setup and Deplovment Projects
+-[_7] Other Projects
[C7 wisual studio Solutions

Windows lass Library
Applicatian

Control Library  Application

& praject For creating classes ko use in ather applications

=l

Managed
add-In

Windows Smark Device  ASP.MET Web

Application

Mame: | Aritmetical

" Close Solution

| CADocuments and Settingsipsousal My Dncuments'l,.ﬁ.ctiﬂ Browse, .,

Praoject will be created at Cih, . \Actividade LectivaiDisciplinastabai ExemplodrtimeticaMet Aritrmetica,

FMorg O, | Cancel

| Help |

Figura 15 — criar um projecto tipo Class Library em C# e adicionar a uma solucéo existente

O Visual Studio vai criar o projecto e criar uma série de ficheiros pré-definidos. No “Solution

Explorer” remover o ficheiro classl.cs.

Em seguida iremos especificar o contrato (a interface) do nosso componente, ou seja, que

operacdes e que parametros recebe cada operacdo estdo disponiveis para a execuc¢ao de

7

um servico. No nosso exemplo o servico que pretendemos fornecer € o de calculos

aritméticos basicos. Para tal, vamos adicionar uma interface ao projecto; clicando com o

botdo do lado direito do rato em cima do projecto, escolher a op¢do Add - Add New Item e

criar uma classe chamada IAritmetica.
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f "1'
Add Mew ltem - Aritmetica
IEE ::::l
Categaries: Templates: OB o-n-
[C3 Microsoft IFE Wizard Framework A

+1- Local Project Items i @
+-[_] Rational %DE

Windows Form Class Component
(£ Rational XDE User Defined Class
i T -_
: Y e |[E]
e ¢
Ilser Control Daka Faorm [Daka Set
Wizard

. .
&
=

#ML File ¥ML Schema Code File

(]
An empty class declaration

Marme: Iaritmetica.cs

Cpen Zancel Help

Figura 16 - adicionar uma classe a um projecto

Em seguida substituir a palavra class por interface e retirar o construtor gerado por
omissao.
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|v; Aritmetica - Microsoft Yisual C# .NET [design] - lAritmetica.cs

-:TIJ

File  Edit iew Project Build Debug Tools  PurifyPlus  Window  Help

H-ta-S @ $ BE o-o-&-6E ) pebug - delete

- BEERE-, EHe XN,

ElRbae S T2 4%%%.
Start Page  IAritmetica.cs | b X ‘Sulutiun Explorer - Aritmetica 1 x |
3B | [0 aritmetica.taritmetica = =l oo
é‘ using System: — Q Solution Exemplodritmeticallet’ {1 proje
= — = IE?J Aritmetica
- [ namespace Aritwmetica 2 @ References
‘ B AssemblyInfo.cs
ii s arys B TAritmetica.cs
— J/Y Summary description for IAhritmetica.
A < sunmarys
public interface IAritwetics
{
}
i
<] 1l | [l]
s |Bdc. [@c. AL [&ls.
‘Properties oo |
| o
| A
E;: 24 | |
E
4 | v
OutpE x|
Microsoft IPE Wizard Framework ;I
Microsoft IPE Wizard Framework Output Window Service loaded.
< i | [ll
Task List  E] oukput | Eg Find Results 1 |% Index Resulks |@ Search Resulks ‘ [ Propetties | @ Dynamic Help |
| Itemis) Saved

o [1ns

cole ch3 | s

Figura 17 — esqueleto da interface

Mudando de vista no solution explorer para se ver as classes existentes no projecto (class

explorer — ver Figura 18), adicionar a interface um método usando o bot&o do lado direito do

rato (Figura 19).
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< | Class Wiew - Aritmetica o X
[ -8 =-

=4} Aritrmetica
== Taritmetica
6iI; Bases and Interfaces
=@ Adicac(Float, Aoat)
=@ Divisao(float, Float)
iz Mulbiplicacao(float, Float)
“..=@ Subtracao(float,Float)

@5 B S @ s

1 x|

| Properties

Figura 18 — vista de estrutura de classes no class explorer

Class Wiew - Aritmetica o x
et 8-
=zl Aritmetica
=l A} Aricmetica
[] o feibrockic 2
@ Go To Definition
8 Go To Reference
_f; Browse Definition
ﬁ<> Quick, Find Symbol
4 AddMethod.. | Add b

@ add Property. ..
] Add Indexer...

@= e

Crymamic Help
& 2] &l

Eﬂl Help

Class View

@h Samples

[P 5% 3% || & 0F & w0 1L

Synchronize

Reverse Engineer

Copy

Sort alphabetically
Sork By Type

Sork By Access
Group By Type

Properties

Yisual Skudio Samoles

Figura 19 — adicionar um método a uma interface via wizard (passo 1)
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C# Interface Method Wizard - Aritmetica

Welcome to the C# Add Interface Method Wizard

This wizard adds a method to wvour C# interface.

Return type: Method name:

| Float ;I |F'.|:|i|:a|:|

Modifier; Parameter type; Parameter name: Parameter list:

INu:une ;I I Float ;l ||:||:|2 Float opl
add Remove

Comment ()} notation not required):

I.ﬁ.dicinna dois ndimeras|

Method signature:

|FI|:|at Adicao(float op1)}{

Finish | Cancel | Help

Figura 20 - adicionar um método a uma interface via wizard (passo 2)

O wizard vai automaticamente criar o método no ficheiro fonte.
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|w Aritmetica - Microsoft Yisual C# .NET [design] - lAritmetica.cs®

MEY %]

File  Edit iew Project Build Debug Tools  PurifyPlus  Window  Help

H-tn-SHE % B ) - &- » Debug - delete

- BEERE-, EHe XN,

ElRbae S T2 4%%%.
Start Page IAritmetita-ts“\ 4 b % || Class View - Aritmetica 1 x
3 | [ aritmetica. Larimetica RN = (IO R
§ using 3Iystem; — = [E;’ﬂ Aritmetica
- -
T — =1 {} Aritmetica
%

[ namespace Aritwmetica
{
H A7 cswmmary:
— J/Y Summary description for IAhritmetica.
A4 < swmary-
public interface IAritwetics
{

T—t

FA4 csummary>

/474 bdiciona dois mimeros

/Al </ sunmar v

float Adicao(float opl, float op2):

‘ |

=|--==0 LAritmetica
] &g Bases and Inkerfaces
=@ Adicao(Float, Float)

s, B |@c. QL [&ls.
‘Properties 1 Kl

| -

R EN=!

Oukput

Microsoft IPE Wizard Framework

Microsoft IPE Wizard Framework Output Window Serwvice loaded.

< il

| [2]

TaskList E] Cutput 5@. Find Resulks 1 |% Index Resulks |@ Search Results ‘

Propetties 9 Dynamic Help |

| Reeady

I |[Lns Col 33 ch30 | s

Figura 21 — cédigo gerado automaticamente pelo wizard de adicdo de métodos

Da mesma forma adicionar os restantes métodos para a subtraccao, divisdo e multiplicacao.

E também possivel escrever os métodos directamente no editor de texto sem usar o wizard.
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|m Aritmetica - Microsoft Yisual C# .NET [design] - lAritmetica.cs u !
File  Edit iew Project Build Debug Tools  PurifyPlus  Window  Help
B-a-c@@ $B@ o-c -85 ) oo - @ delre - BEBRTF-,  EeE s,
ElRbae S T2 4%%%.
Start Page  IAritmetica.cs | < b X || Class View - Aritmetica 1 x
R |°-OAritmetica.IAritmatica ﬂ ":':O j SN el =
§ using Jystem: —1 | = aritmetica
- P
g =1 {} Aritmetica
- [ namespace Aritwmetica =}-e=0 Aritmetica
‘ ] &g Bases and Inkerfaces
1 1ii s — = Afjl.cao(ﬂoatjﬂoat)
o . =@ Divisaoifloat, Ffloat)
J/Y Summary description for IAhritmetica. =@ Multiplicacan(float float)
= )
r /14 </sunmnary> =@ Subkracanifloat,float)
= public interface IAritwetics
{
= FA4 csummary>
/474 bdiciona dois mimeros
r £ </ summar v
float Adicao(float opl, float op2):
float Iubtraceo(flost opl, float opZ): RS‘. EC‘. @C‘. @I.. @S..
float lell?lpllcacan(flnst opl, float apZ): FipiES 1 x
float Diwvisao(float opl, float opZ):
L | =
' | 2
El
4 *
Cutput 2 x
Microsoft IPE Wizard Framework j
Microsoft IPE Wizard Framework Output Window Service loaded.
<] E
Task List  E] oukput | Eg Find Results 1 % Index Resulks @ Search Resulks Propetties | @ Dynamic Help
Itemis) Saved Ln 10 Cal 22 Ch 16 NS

Figura 22 — interface para o servico de aritmética

Em seguida vamos criar o prestador de servicos propriamente dito, ou seja, a
implementacdo dos métodos definidos na interface anterior. Para tal, vamos adicionar uma
classe ao projecto, seleccionando no class explorer o projecto “Aritmetica” e com o botéo do

lado direito do rato em cima do projecto, escolher a opcdo Add - Add Class.
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4 ¥ Class View - Aritmetica n x

Biuild
= Febuild

“g Add Class... Add J

Set as SkartUp Project
Debug 3

Synchronize

4w Tl

Reverse Enginest

| Save Aritretica
— = % Sort Alphabetically
T

¥s | Sort By Twpe

Properties .::,I Sort By fooess
| Aritmetice {2 Group By Type

B8 -
Z| 2 E| Propetties
=

Figura 23 - adicionar uma classe via wizard a partir do class explorer (passo 1)

Ira aparecer o wizard de criacdo de classes (Figura 24) no qual indicaremos o nome da

classe a criar e uma pequena descrigcao.
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C# Class Wizard - Aritmetica

Welcome to the C# Add Class Wizard

This wizard adds a C# class ko vour project,

Class name: Mamespace:
i Class Options 2 o F
|aritmeticalmpl | Aritmetica j
Base Class
File name: ACcess:
Inheritance |.ﬁ.ritmeti|:aIm|:ul.|:5 J ||:uu|:u|i|: j
Class modifiers:
{* Mone
{ Abstrack
" Sealed

Comment () notation not required):

|imp|ementa;§|:| do servico de aritmetica

Finish | Cancel | Help

Figura 24 - adicionar uma classe via wizard a partir do class explorer (passo 2)

Em seguida iremos indicar caracteristicas de heranca desta classe seleccionando o

separador “Inheritance” do lado esquerdo da janela do wizard (Figura 25).
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Inheritance

specifies the interfaces vour class will implement.

Current namespace:
| Aritmetica ;l

Available interfaces:

Inheritance

add Add all Remove Remove

Selected interfaces:

Finish | Cancel | Help

Figura 25- adicionar uma classe via wizard a partir do class explorer (passo 3)
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|m Aritmetica - Microsoft Yisual C# .NET [design] - Aritmeticalmpl.cs u@]
File  Edit iew Project Build Debug Tools  PurifyPlus  Window  Help
A-o-cHd b8 8- ) oebu - g delete - BEERRB-, e L,
EH %R e T2 A4%%%.
Start Page | Laritmetica.cs Aritmetitalmpl.ts| < b X || Class View - Aritmetica o x
2 e =l e o EREEE
§ }.13 ing Jystem: —1 | = aritmetica
- P
= =1 {} Aritmetica
2 + QQ Arikmeticalmpl
[ namespace Aritwmetica P
: == LAritmetica
+ a(g Bases and Interfaces
T £ ?S ary> . . =@ Adicaoifloat, Flaat)
/77 implementagfo do servigo de aritmetica =@ Divisan(float, flaat)
= )
r /14 </sunmnary> =@ Multiplicacanifloat, Float)
= public class Aritmweticalmpl @ Aritmetics. IAritmetica @ Subkracaoifloat Float)
= )
{
i public Aritmeticalmpl ()
i
I
44 TODO: Add constructor logic here
i
L } ods. Fc. [@c. AL [dls.
_} Y Properties o X
L | =
| 2
El
4 *
Qutput n

Microsoft IPE Wizard Framework

|« x

Microsoft IPE Wizard Framework Output Window Serwvice loaded.

< 2
Task List  E] oukput | Eg Find Results 1 % Index Resulks @ Search Resulks [ Propetties | @ Dynamic Help
Reeady Ln1 Cal 1 Chi NS

Figura 26 — classe gerada para implementacao do servico

Vamos em seguida implementar os metodos definidos na interface. Para isso no class
explorer escolher das classes bases e interfaces da classe Aritmeticalmpl, o item com

a interface lAritmetica e com o botdo do lado direito escolher Add - Implement
Interface (Figura 27).
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4 [ x| Class Wiew - Aritmetica o x

S | M =
—1|| =--E# Aritmetica
- = {} aritmetica
- QI; Aritreticalmpl
- QI; Bases and Interfaces

+ QI; Chiject

1o HAFFrekica:
W 30 To Definition

41 B Go To Reference

_%  Browse Definition
: ﬁ<> Cuick, Find Symbiol
"* Implement Interface. ., Add »
g AddMethod... =  Synchronize
i Add Property... =+:_, Reverse Engineer
11 Add Indeger...

IAritmetica Copy

E: iz‘a* % Sort Alphabetically
g ¥%, Sort By Type
- (Marme) f:”_l Sort By Access
LH Geee {% Group By Type
1 x Properties

Figura 27 — implementar um interface

O Visual studio gerou o esqueleto de codigo associado a interface IAritmetica e alterou

o ficheiro fonte da classe Artimeticalmpl conforme se pode ver na figura seguinte.
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|v; Aritmetica - Microsoft Yisual C# .NET [design] - Aritmeticalmpl.cs™

File  Edit iew Project Build Debug Tools  PurifyPlus  Window  Help
B-in-cd@ $BE 9-o -85 ) g - | o delete - BEERE-, EHe XN,
ElRba S5 22 4%%%.
B start Page | Taritmetica.cs  Aritmeticalmpl.cs™ | 4 b % ‘C\ass View - Aritmetica o x
R IalgAritmetica.nr\tmet\calmp\ j I':':‘ j Mot R
§ public class Aritmeticalmpl : Aritmetica. IAritmetica = @ﬂ Aritmetica &
T { = {} Aritmetica
& = @g Aritreticalmpl
= public Aritmeticalmpl () P
¢ = Bases and Inkerfaces
Py -9 Obiject
7 TR MR . - s O +-o= TAritmetica =
— H constructor logic here .
o el =@ Adicao(float, Float)
=@ Aritmeticalmpl()
¥ =@ Divisao(float,Float)
r =@ Multiplicacaoifloat, Floa
= #region IAritwetica Mewbers =@ Subkracanifloat,float)
=|--==0 LAritmetica
= puklic float Adicao(float opl, float op2) + a(; Bases and Interfaces
[ - AddiranfFlask Flaskh M
i [&] I | m
A4 TODO:  Add Aritmeticalmpl.idicac implementation
return 0O; ES‘. EC‘. @Cl@l |@S|
. ‘Properties oo |
= puklic float Subtracao(float opl, £loat op2) I j
{ EEEE
A4 TODO:  Add Aritmeticalmpl.Subtracac implementation
return O;
' -
] | »
| output 2 x|
Microsoft IPE Wizard Framework ;I
Microsoft IPE Wizard Framework Output Window Service loaded.
<] 1l | 2]
Task List  E] output | Bg Find Results 1 |% Index Resulks |a Search Resulks ‘ [ Propetties | @) Dynamic Help |
| Ready I Ln 16 Col 1 chi | Jms|

[ D2 Win... 'ﬂ ﬁglnte... vn @Inbux-... n @Gu\au i

*3 Aritmeti. .,

W untitled... r@ W07 W& D 2027

Figura 28 — classe de implementagéo do servico com esqueleto dos métodos da interface

Colocar o seguinte cédigo na implementacao do método:

/// <summary>

/// adiciona dois numeros

/// </summary>

public float Adicao(float opl, float op2)

{
}

/// <summary>

/// Subtrai dois numeros

/// </summary>

public float Subtracao(float opl, float op2)

{
}

/// <summary>
/// Multiplica dois numeros
/// </summary>

return opl+op2;

return opl-op2;

public float Multiplicacao(float opl, float op2)

{
}

/// <summary>

return opl*op2;
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/// Divide dois numeros
/// </summary>
public float Divisao(float opl, float op2)

{
it (op2 1= 0)
return opl/op2;
else
throw new ApplicationException(“Tentativa de
efectuar uma Divisdo por zero ™);

}

De notar que na implementacdo do método Divisao() recorremos a excepcles para
indicar ao utilizador desta classe situagbes andémalas. Neste caso utilizamos a classe
predefinida ApplicationException, embora fosse possivel definir as nossas proprias

excepcoes®.

Compilar (ndo deve dar erros).

5.4 Consolade teste

Vamos agora criar um novo projecto para testar o componente anterior. Usar File > New e

escolher um novo projecto garantindo que se adiciona esse projecto a solucdo actual.

8 para mais informacdes sobre criagdo, lancamento (throw) e tratamento (try-catch) de excepcdes ver

http://msdn.microsoft.com/library/en-us/cpquide/html/cpconhandlingthrowingexceptions.asp?frame=true
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- n
New Project
Project Types: Termnplates: 8o 25251
+-[_7] Microsoft IPE Wizard Framework [ |

[ wisual Basic Projects é‘ ﬁ| @ [ﬁ

) Wisual C# Projects r = #

[ wisual J# Projects Smart Device  ASP.MET Web ASP.MET Web
+-] Visual C++ Projects Application Application Service

[:_"l Rational %DE Modeling Projects 3 s ¥

[_] Setup and Deplovment Projects @ =
+-[_7] Other Projects

(] visual Studio Saluti ASP.MET Web Control Console

t=al StLdio anlutons Mobile W, . Library application %

& praject For creating a command-line application

Mame: | TestedritmeticaConsolal

] C:ADocuments and SettingsiPaulo Sousal My Document LJ Browse,

" Close Solution

L

(+ Add to Solution

Praoject will be created at C:h, . \Disciplinas) A0AW Exemplofritmeticalet! TestedritmeticaConsala,

FMore (] 4 | Cancel ‘ Help ‘

Figura 29 — criar um novo projecto de consola em C#

Para que possamos usar o componente anterior temos que adicionar uma referéncia ao

componente. Para isso usamos o botdo do lado direito do rato sobre o item “references” no

solution explorer.

Solution Explorer - Testefritmetica,., @ X
E(E] &2
@ Solution 'Exemploaritmeticablet’ (2 projed
= IE?_] Aritmetica
+- [13] References
[#] AritmeticaImpl.cs

[#] AssemblyInfo.cs
B IAritmetica. cs

add Reference. ..
add Weh Reference. ..

S

<] B
B [Fc (@ A1 [ds.

Figura 30 - Adicionar uma referéncia a outro projecto (passo 1)
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Add Reference

MET | com  Projects |
Browse, .,

Projeck Mare | Project Direckary |
srikmekica C:\Documents and Settingsipsousal My Docun, .,

I

Selected Components:

Component Mame Tvpe | Source | Remove
Aritmetica Project C:\Documents and Settingsipso.., .
(] 4 | Cancel | Help

Figura 31 — Adicionar uma referéncia a outro projecto (passo 2)

No ficheiro classl.cs criado automaticamente, procurar o método Main() e colocar o
seguinte cédigo:

static void Main(string[] args)
{

5;

7;

int opl
int op2

//declarar objecto para o servico que pretendemos - interface
Aritmetica.lAritmetica comp;

//criar objecto com implementacdo do servico
comp = new Aritmetica.Aritmeticalmpl();

//invocar o servico pretendido
Console _WriteLine("Adicdo({0}, {1}) => {2}",
opl, op2, comp.Adicao(opl, op2));

}
O método WriteLine() permite a indicacdo de parametros indicados pelos niumeros entre
chavetas, para uma string de formatacdo. Para mais informacdo sobre o método

WriteLine() consultar http://msdn.microsoft.com//library/en-

us/cpref/html/frirfsystemconsoleclasswritelinetopic15.asp; para informacéo sobre as strings
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de

us/cpguide/html/cpconcompositeformatting.asp.

formatacéo

http://msdn.microsoft.com/library/en-

Para testar é necessario indicar ao Visual Studio qual o projecto a executar quando constam

varios projectos na mesma solucdo. Para tal, com o botdo do lado direito em cima do

projecto no solution explorer, escolher “Set as startup project” (Figura 32).

Solution Explorer - Testedritmetica,,, & X

[2]

=

A =]

@ Solution 'Exermplofritmeticaket’ (2 projed
- IE;‘H Aritmetica

[=5] References

Ehl Aritrneticalmpl.cs

Ehl fssernblyInfo.cs

Ehl Iaritmetica.cs

= ul;g T Y

+

Misc

4w Tl

Ewild

Rebuild

Project Dependencies. . .

Project Build Crder. ..

Add »
Add Reference...

add Web Reference. ..
Synchronize

Reverse Enginest

Set as Starklp Project
Debiug 3

Save TestedritmeticaConsala

Rermowve

Rename
Properties

WSE Setkings 2.0...

Figura 32 - seleccionar um projecto como projecto inicial para execugéo

Compilar e testar.
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B3 "C:\Documents and Settings\Paulo Sousa\My DocumentsiVisual Studio Projects\Exemploarit... - |O ﬂ
Adigancs,. 7> => 12 H

Press any key to continue_ .

Figura 33 - aspecto geral da aplicacdo de consola

5.5 Aplicagdo Winforms de teste

Vamos agora criar outro tipo de cliente, uma aplicagdo windows neste caso em Visual

Basic.net. usando File > New adicionar um novo projecto a solugéo.

Este projecto utiliza a linguagem de programacdo Visual Basic .net e ndo C# para
demonstrar que € possivel utilizar componentes escritos numa dada linguagem de
programacdo a partir de clientes (programas ou outros componentes) escrita noutra

linguagem de programacao.
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-

Mew Project

Project Types:

Templates:

+-[_7 application Architecture For MET Wizard
=3 Wisual Basic Projects
(L7 wisual C# Projects
(L wisual 1# Projects
+-[_7 wisual C++ Projects
[C3] setup and Deplovment Projects
+-[_7] Other Projects
[C7 wisual studio Solutions

gl @

Class Library

Windows
Conkral Library |

Windows
Applicatian
L—_ ¥

Smart Device ASP.MET Web ASP.MET Web
Application Application Service

& praject For creating an application with a Windows user interface

Marne: | Teste.ﬁ.ritmeticaWinFrDms|

FMore

oo | CADocuments and Settingsipsousal My Dncuments'l,.ﬁ.ctiﬂ Browse, .,
< {+ Add to Solution > " Close Solution

Praoject will be created at C:h, . \Disciplinas) A0AYW Exemplofrtimetic alet! TestenritrmeticainFrams,

o ]

Cancel | Help |

Figura 34 — criar um projecto WinForms em VB.net

Adicionar a referéncia ao componente como foi feito no projecto anterior.

Usando o editor visual construir o formulario da aplicacdo para que se pareca com o da

imagem seguinte (utilize a janela “Properties” para atribuir os valores das propriedades dos

controlos de acordo com a Tabela 4).
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|w TesteAritmeticaWinForms - Microsoft Yisual Basic .MET [design] - Form1.vb [Design]

BEX]

File Edit “iew Project Buld Debug Data Tools  PurifyPlus  Window  Help
@'ﬁ'@ = p Debug v [ delete

Toolbox o x
My User Controls

Data

Components

Windows Forms -
3| Button

[abl TextBox

E MainMenu

¥ CheckBox

& RadioButton

m GEroupBox

PictureBox

I:‘ Fanel

51 DataGrid

B ListBox

CheckedListBox

=8 ComboBox

237 Listview

Start Page | Iaritmetica.cs | Aritmeticalmpl.cs | Classi.cs Furml.vb[Design]|

- BREHRTEH-. @ N,

4 [+ X || Solution Explorer - TeskeAritmetica,,, I X

EE @8 -
+ (i3] References ~
[®] aritmeticalmpl.cs b |
B AssemblyInfo.cs
B IAritmetica.cs
= @Testenritmeticatonsola
+. (i3] References
App.ica
Iﬁ AssemblyInfo.cs
Classl.cs
= Testenr\tmeticaW\nForms
+ (i3] References
2] AssemblyInfa,vh

Forml . vb r
.v.

@5 [T @R 6=

Froperties 7 x

|cbl:lperacao System.Windows.Forms.(ﬂ

47 Tresview E: 2
Clipbaard Ring ht (DynamicPropertie: j
Genetal =]
Server Expl... 32* Taohox {DataBindings)
DataSource {rione)
Output 1 x DisplayMember  (Monel
|Build g !tams {Collection) ] —
Done [ |72
walueMember
=
Build: Z succeeded, 0 failed, 0 skipped = J
Text
| | The text contained in the contral.

Task List ] output | Eg Find Results 1 % Index Results @ Search Resulks

Ikemis) Saved

D3 win., ~| @3 nte.. ~| [O]2 Micr...

i) T T

Properties 9 Crwniamic Help

| B Guiag ... M 14 urtitled... @-IJ@&«@@ 14143

Figura 35 - adicionar itens alfanuméricos a uma ListBox ou ComboBox (passo 1)

Tabela 4 — propriedades dos controlos da aplicacdo WinForms

Elemento | Propriedade | Valor

12 text box | Name txtOp1

12 text box | Text

22 text box | Name txtOp2

22 text box | Text

combobox | Name cbOperacao
1° botao Name btnExecutar
1° botao Text Executar

2° botéo Name btnSair

2° botéo Text Sair

(c) Paulo Sousa
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1° label Text 1° operando
2° label Text 2° operando
32 label Name IbIResultado
3° label Text Resultado

A ComboBox pode ser preenchida com valores em tempo de desenho usando a

propriedade Col lection.

o S

String Collection Editor

Enter the strings in the collection {one per line);
Adicdo

Subkracdo

Mulkiplicacdo

Divis&o|

QK ancel Help

.

Figura 36 — adicionar itens alfanuméricos a uma ListBox ou ComboBox (passo 2)

Para testar a adi¢do, criar um método de evento® associado ao botdo de executar. Para isso

efectuar um duplo click no botéo e no método gerado colocar o seguinte codigo:

Private Sub btnExecutar_Click(ByVal sender As System.Object,
ByvVal e As System.EventArgs)
Handles btnExecutar.Click

° para mais informacdes sobre tratamento de eventos em aplicacbes que utilizam Win Forms

consultar http://msdn.microsoft.com/library/en-us/vbcon/html/vbconeventhandling.asp; para

informacdo geral sobre o0 mecanismo de eventos na plataforma .net consultar

http://msdn.microsoft.com/library/en-us/vbcon/html/vborieventhandlers.asp.
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Dim operl As Single

Dim oper2 As Single

“declarar variavel

Dim comp as Aritmetica.lAritmetica

= Single.Parse(txtOpl.Text)
= Single.Parse(txtOp2.Text)

“criar objecto com implementacdo do servico
comp = New Aritmetica.Aritmeticalmpl

IbIResultado.Text = comp.Adicao(operl, oper2)
End Sub

Vamos também inicializar o formulario criando o método que trata o evento de
carregamento do formulario (indicado pela palavra reservada Handles e pelo evento
Load), fazendo um duplo click em qualquer area livie 0 mesmo e colocando o seguinte

cadigo na fungéo gerada.

Private Sub Forml Load(ByVal sender As System.Object,
ByVal e As System.EventArgs)
Handles MyBase.lLoad
“colocar como seleccionado a 12 opcdo da listbox
cbOperacao.SelectedIndex = 0
End Sub

Finalmente vamos colocar c6digo associado ao botdo de saida da aplicacdo para fechar a

janela e sair da aplicacéo.
Private Sub btnSair_ Click(ByVal sender As System.Object,
ByVal e As System.EventArgs)
Handles btnSair.Click

Me.Close()
End Sub

Seleccionar o projecto “TesteAritmeticaWinForms” como projecto start up, compilar e testar.

55 Form1 E]@W

-~

12 operando |-|

2! pperando |2
|.-i‘-.|:|iu;§|:| j E wecutar |
3

S air

Figura 37 — aspecto geral da aplicacdo windows

Vamos agora colocar em funcionamento as restantes opgoes:
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Privat

e Sub btnExecutar_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs)
Handles btnExecutar.Click

Dim operl As Single

Dim oper2 As Single

“declarar variavel

Dim comp as Aritmetica.lAritmetica

operl = Single_Parse(txtOpl.Text)
oper2 = Single_Parse(txtOp2.Text)

“criar objecto com implementacdo do servico
comp = New Aritmetica.Aritmeticalmpl

IT cbOperacao.Selectedltem = "Adicao" Then
IblResultado.Text = comp.Adicao(operl, oper2)

End IT

IT cbOperacao.Selectedltem = "Subtraccdo™ Then
IblResultado.Text = comp.Subtracao(operl, oper2)

End If

IT cbOperacao.Selectedltem = "Multiplicacdo'" Then
IblResultado.Text = comp.Multiplicacao(operl, oper2)

End If
IT cbOperacao.Selectedltem = "Divisdo"™ Then
IblResultado.Text = comp.Divisao(operl, oper2)
End IFf
End Sub

Compilar e testar.

Como se pode ver, no caso da divisdo, se tentarmos dividir por zero o programa gera uma

excepcdo. Podemos programaticamente controlar essa excepcdo fazendo a seguinte

alteracéo:
IT cbOperacao.Selectedltem = "Divisdo" Then
Try
IblResultado.Text = comp.Divisao(operl, oper2)
Catch ex As ApplicationException
System._Windows.Forms.MessageBox.Show(*’'Ndo pode dividir
por Zero.')
End Try
End IT

Compilar e testar.

Adicionalmente, pode também ser gerada uma excepc¢do caso se introduzam caracteres

nNAo numeéricos nas caixas de texto (ou mesmo se a caixa de texto estiver vazia) quando se

tenta fazer o Single.Parse(). Para corrigir esse problema devemos alterar o codigo do

método para o seguinte:

Private Sub

btnExecutar_Click(ByVal sender As System.Object,
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ByVal e As System.EventArgs)
Handles btnExecutar.Click
Dim operl As Single
Dim oper2 As Single
"declarar variavel
Dim comp As Aritmetica.lAritmetica

"criar objecto com implementacdo do servico
comp = New Aritmetica.Aritmeticalmpl

Try
operl
oper2

Single.Parse(txtOpl.Text)
Single.Parse(txtOp2.Text)

IT cbOperacao.Selectedltem = "Adicao" Then
IblResultado.Text = comp.Adicao(operl, oper2)

End IT

IT cbOperacao.Selectedltem = "Subtraccdo'™ Then
IblResultado.Text = comp.Subtracao(operl, oper2)

End If

IT cbOperacao.Selectedltem = "Multiplicacdo'" Then
IbIResultado.Text = comp.Multiplicacao(operil,
oper2)
End If
IT cbOperacao.Selectedltem = "Divisdo" Then
Try
IbIResultado.Text = comp.Divisao(operl,
oper2)
Catch ex As ApplicationException
System.Windows.Forms.MessageBox.Show(*'Nao
pode dividir por Zero.'")
End Try
End If
Catch ex As FormatException
System_Windows.Forms._MessageBox.Show(*'Por favor preencha
as caixas de texto apenas com numeros'")
End Try
End Sub

Compilar e testar.

5.6 Aplicacdo ASP.net de teste

Vamos agora utilizar o nosso componente a partir de uma aplicacdo web, para iSso criar um

novo projecto web em C# na solu¢do que temos vindo a usar.

NOTA: nos laboratérios do DEI ndo sera possivel criar este projecto pois 0s alunos nao tém
permissdes de escrita num servidor web que suporte ASP.net.
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Figura 38 — criar um projecto tipo aplicagdo web asp.net em C#

E adicionar a referéncia ao componente tal como foi feito nos passos anteriores.
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Figura 39 — toolbox de controlos disponiveis para formularios web

Usando a toolbox, desenhar o formulario que se pode ver na figura seguinte.
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Figura 40 — formulario web a criar para testar componente

Para este exemplo vamos utilizar um botdo para cada operacéo. Para se colocar o botdo de
adicdo a funcionar vamos associar um método ao evento de click do botdo. Para isso
fazemos duplo click sobre o bot&o e o Visual Studio automaticamente vai criar um método e
associa-lo ao evento click. Nesse método colocar o seguinte codigo.

using Aritmetica; // simplifica a escrita do coédigo

private void btnAdicao Click(object sender, System.EventArgs e)
{

IAritmetica comp = new Aritmeticalmpl();
try

IbIResultado.Text = comp.Adicao(
float.Parse(txtOpl.Text),
float.Parse(txtOp2.Text)
)-ToString();

}

catch (FormatException ex)

IbIResultado.Text = "";
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De reparar que agora em C# é necessario converter os valores da caixa de texto de strings
para inteiros usando o método Float.Parse() e em seguida converter o resultado inteiro
para string para ser visualizado usando o método ToString(). Neste exemplo também
tratamos um caso adicional em que o utilizador tenha colocado caracteres ndo numéricos
nas caixas de texto tratando a excepcdo FormatException que € gerada pelo método
float.Parse(). Adicionalmente, o tratamento de eventos em C# é diferente do Visual
Basic ndo existindo em C# o equivalente a palavra reservada Handles do VB; para
associar o evento ao handler, o visual studio adicionou a seguinte linha de cédigo no

método de inicializagcdo da pagina web (Initial izeComponent):

this.btnAdicao.Click +=
new System.EventHandler(this.btnAdicao Click);

Compilar e testar.

Para colocar os restantes bot6es a funcionar, basta criar os métodos para os eventos de

click e colocar nesses métodos o seguinte cédigo.

private void btnSubtracao Click(object sender, System.EventArgs e)

{
IAritmetica comp = new Aritmeticalmpl();
try
IbIResultado.Text = comp.Subtracao(
float.Parse(txtOpl.Text),
float.Parse(txtOp2.Text)
)-ToString();
catch (FormatException ex)
IbIResultado.Text = ""';
}
}
private void btnMultiplicacao Click(object sender, System.EventArgs
e)
{

IAritmetica comp = new Aritmeticalmpl();
try

IbIResultado.Text = comp-Multiplicacao(
float.Parse(txtOpl.Text),
Ffloat.Parse(txtOp2.Text)
)-ToString(Q);

catch (FormatException ex)

{
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IbIResultado.Text = "";
}
}
private void btnDivisao_Click(object sender, System_EventArgs e)
{
IAritmetica comp = new Aritmeticalmpl();
try
IbIResultado.Text = comp.Divisao(
float.Parse(txtOpl.Text),
float.Parse(txtOp2.Text)
)-ToString();
catch (FormatException ex)
IbIResultado.Text = ""';
catch (ApplicationException ex)
IbIResultado.Text = ""Ndo é possivel dividir por zero";
}
}

Compilar e testar.

Como conclusdo podemos dizer que criar componentes em .net € tao facil como criar uma
classe e coloca-la numa Class Library para que possa ser reutilizada em formato binario.
Esse componente pode entdo ser utilizado de forma igual em varios tipos de clientes e em
varias linguagens de programacao. Para se conseguir reutilizar o componente apenas

necessitamos de adicionar uma referéncia ao componente/projecto.

5.7 Melhorias propostas e questdes

1 Criar um cliente em Winforms usando linguagem C# e com botbes separados

para cada operacao

2 Criar um novo servico no componente para concatenacdo de duas string e

modificar os clientes anteriores para testar este novo método.

3 Pesquise o significado da palavra reservada params em C# e implemente o

seguinte método:
public string Concatenar(params string[] args)

implemente num dos clientes uma funcéo para teste deste novo método.
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6 Guido de trabalho: Evolucdo do componente para operacdes

aritméticas

6.1 introducéo

Um aspecto importante do desenvolvimento orientado aos componentes € a evolugdo das
interfaces dos mesmos. No caso do componente de aritmética desenvolvido na sec¢ao 5.3,
vamos querer criar uma nova versdo do componente com funcionalidades adicionais, por

exemplo, a operacao poténcia.

Um aspecto muito importante a ter em conta, é que uma vez uma interface publicada (ou
seja, potencialmente utilizada por outras aplicaces), essa interface torna-se imutével. Ou
seja, nao se devem alterar as interfaces ap6s a sua definicdo e publicacdo. Caso se

pretenda aumentar funcionalidades cria-se uma nova interface.

6.2 Passos preparatorios
NOTA: este passo apenas € necessario para efeitos de demonstracao

Antes de comecar as alteracbes vamos copiar o directério “bin” da aplicacao de teste de
consola para um directério temporario para mais tarde demonstrar que a evolu¢do do
componente ndo implicou alteragbes nem recompilacdo das aplicagbes clientes ja

existentes.

6.3 Alteracdes ao componente

Vamos abrir 0 projecto anterior e criar uma nova interface chamada 1Aritmetica2 que

deriva de IAritmetica de acordo com o seguinte cAdigo:

public interface lAritmetica2 : lAritmetica

{

double Potencia(float b, int expoente);
double RaizQuadrada(float n);

}

Vamos agora implementar esta nova interface. Para isso vamos abrir o ficheiro da classe
Aritmeticalmpl. No cddigo vamos acrescentar a declaracdo da interface que
pretendemos implementar (IAritmetica2). De reparar que o visual studio ird perguntar se
pretendemos gerar automaticamente o esqueleto para os métodos definidos na interface,

bastando para tal pressionar na tecla TAB (Figura 41).
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Figura 41 - geracdo automatica de interface

Para implementar os métodos iremos utilizar os métodos existentes na classe Math da

plataforma .net.

public double Potencia(float b, int expoente)
{

}

public double RaizQuadrada(float n)
{

}

return Math.Pow(b, expoente);

return Math.Sqrt(n);

Compilar, ndo deve dar erros.

6.4 Aplicacao de teste

Para experimentar esta nova versdo do componente iremos criar uma nova aplicagdo de

teste adicionando um novo projecto de consola em C#, denominado “TesteArti2” a solucéo.
Adicionar a referéncia ao componente.

Para testar colocar o seguinte cddigo:
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// criar instancia do componente e requisitar nova interface
Aritmetica. lAritmetica2 comp = new Aritmetica.Aritmeticalmpl();

int b = 2;
int e
float n = 25;

I
N

System.Console _WriteLine("{O}{1} = {2}\n"", b, e,
comp.Potencia(b, €));
System._Console_WriteLine(''raiz quadrada de {0} = {1}\n", n,
comp.RaizQuadrada(n));
Definir este novo projecto como startup project.

Compilar (ndo deve dar erros) e testar.

6.5 Teste da aplicacéao cliente para versao anterior
Efectuar os seguintes passos:

1. abrir uma janela do explorer ou linha de comando no directério temporario para onde

se copiou a aplicagdo de teste
2. executar o programa

3. verificar na janela do explorer a versdo da DLL correspondente ao nosso

componente (Figura 42)

J C:\Documents and Settings\Paulo Sousa'\My DocumentsiTempitestearitconsola\Debug g@
Iy
]

File Edit ‘%ew Favorites Tools Help

Q Back ~ I ? /._ ) Search Falders Ev

empltestearitconsolalDebug 1#| a fete)

Address || ) C:\Documents and Settingsye@0 SousalMy Docume

k| Aritmetica.dl
e | 1.0.17258.24831

TestefritmeticaConsola,exe

* Aritmetica,pdb
Program Debug Database
ZOKE

File and Folder Tasks

= Make & new folder

&8 Fublish this folder to the
Weh

i Share this folder

 TestedritmeticaConsola.pdb
Program Debug Database
14 KB

Figura 42 - verséo da DLL da 12 versdo do componente

4. abrir uma nova janela do explorer no directorio “bin” correspondente ao componente

e verificar a versdo da DLL (Figura 43)."

19 As versdes das DLL existentes no vosso computador serdo diferentes das apresentadas na figura.
O que importa reter é que a versao existente é diferente da nova versdo compilada apos as

alteracdes.
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Figura 43 — versdo da DLL para a 22 versdo do componente

5. copiar a nova DLL para o directério temporario
6. executar a aplicacéo e verificar que continua a funcionar.

Com estes passos consegue-se demonstrar que se pode evoluir a aplicacdo e que como se
respeitou o principio da imutabilidade das interfaces as aplicacdes clientes ja existentes

continuam a funcionar sem necessidade de alteracdo de codigo nem sequer recompilacéo .

6.6 Questdes

1 Tendo em conta as alteracdes pedidas para efectuar nos pontos 2 e 3 da sec¢éo

5.7 Melhorias propostas e questdes (pag. 58):

a. Verifique se implementou uma nova interface ou alterou a interface existente

ja publicada. Reflicta sobre a decisao que tomou.

b. serd que esse servico devia ser implementado neste componente ou num

componente separado?

2 Suponha que deseja adicionar um servico para aritmética com numeros
complexos (x+iy). Como procederia para adicionar esse servico ao componente?
Das quatro hipéteses seguintes indique vantagens e desvantagens de cada uma

e escolha justificadamente a op¢édo que seguiria:
a. Alterava a interface existente

b. Aproveitava a alteragcdo actual e incluia esses métodos na interface
IAritmetica2

c. Criava evolucdo da interface existente (eg., IAritmetica3)

d. Criava nova interface, 1ArtimeticaComplexa, separada
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7 Guiao de trabalho: Separacédo da criacéo de classes

7.1 Introducéo

Um dos problemas do componente que temos vindo a trabalhar é que continua a expor
alguns pormenores de implementacdo internos as aplicacdes clientes, nomeadamente a

classe que implementa os servicos. Essa situacdo nem sempre é desejavel.

Por exemplo, a equipa de desenvolvimento podia querer separar a implementacdo da 22
versdo da interface da 12 e para isso criar uma nova classe (ex, Aritmetica2lmpl). No
entanto, essa situacdo traria alguma confuséo aos utilizadores do componente pois agora
teriam duas interfaces e duas classes para perceber e necessitariam de saber que apenas
poderiam usar a interface l1Aritmetica com a classe Artimeticalmpl e a interface

IAritmetica2 com a classe Aritmetica2lmpl.

Por outro lado, a solucdo apresentada também coloca alguns problemas, pois caso se
pretenda estender os servigcos com novas interfaces, a classe de implementacdo comecgara

a ficar muito grande e aumentara a dificuldade de manutencéo de codigo da mesma.

Uma solucéo possivel é recorrer ao padrdo™ Factory e delegar a criacdo das classes de

implementacao de servicos numa classe utilitaria — a fabrica.

7.2 Alteragdo do componente

Vamos abrir o projecto do componente e criar uma nova classe chamada Factory com os

seguintes métodos:

public class Factory

{ public static lAritmetica CreatelAritmeticaService()
{ return new Aritmeticalmpl();
}
public static lAritmetica?2 CreatelAritmetica2Service()
: return new Aritmeticalmpl();

" Um padrdo é uma solucdo tipificada para um problema recorrente. Podem encontrar mais

informacdo em “Design patterns : elements of reusable object-oriented software”, Erich Gamma,
Richard Helm, Ralph Johnson e John Vissides, e obter implementacbes base em C# em

http://www.dofactory.com/Patterns/Patterns.aspx .
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}

Esta classe passa a ser entdo o ponto de contacto com a aplicacéo cliente. O utilizador do
componente apenas nhecessita saber as interfaces existentes e requisitar a fabrica um
objecto que implemente o servico desejado. De notar que se optou por uma regra de

nomenclatura CreateXXXService, em que XXX representa a interface desejada.

Futuras evolucbGes apenas necessitardo da criacdo de novos métodos fabrica. Deve-se ter
em atencdo que o principio de imutabilidade das interfaces também deve aqui ser
respeitado, ndo sendo aconselhavel alterar os métodos fabrica ja existentes, mas sim criar

novos métodos.

Como agora a criagdo das classes estd separada numa classe utilitario, essas classes
podem evoluir de forma independente. Um outro passo necessario é “esconder” as classes
de implementagcdo do exterior, para isso vamos alterar o tipo de visibilidade da classe
Aritmeticalmpl de public para internal. O que faz com que esta classe ndo possa

ser instanciada fora do assembly (neste caso, a DLL) onde é definida.

internal class Aritmeticalmpl : lAritmetica , lAritmetica2

{
}

7.3 Aplicacao de teste

Para experimentar esta nova versdo do componente iremos criar uma nova aplicacdo de
teste adicionando um novo projecto de consola em C#, denominado “TesteFactory” a

solucéo.
Adicionar a referéncia ao componente.

Para testar colocar o seguinte cédigo:

int opl
int op2

5;
7;

// obter implementacdo de servico desejado
Aritmetica.lAritmetica comp =
Aritmetica.Factory.CreatelAritmeticaService();

//invocar o servico pretendido
Console_WriteLine("Adicdo({0}, {1}) => {2}",
opl, op2, comp.Adicao(opl, op2));

Compilar (ndo deve dar erros) e testar.
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7.4 Implicacdes nas aplicacfes ja existentes

Estas alteragbes tém um grande impacto nas aplicagfes ja existentes implicando alteracao

do cédigo fonte e recompila¢éo para utilizagéo da classe fabrica.

Uma hip6tese de minimizar esse impacto € deixar a classe Aritmeticalmpl com
visibilidade public. Desse modo todas as aplicacdes existentes continuam a funcionar
criando directamente a classe de implementagédo, enquanto que 0s novos clientes usariam
apenas a classe de fabrica. Nesse caso, todas as implementacbes de novos servicos

deveriam ser colocadas em novas classes com visibilidade internal.

8 Informacéo Adicional

MSDN Library

http://msdn.microsoft.com/library

Design Guidelines for Class Library Developers

http://msdn.microsoft.com/library/en-us/cpgenref/html/cpconnetframeworkdesignguidelines.asp

.net framework center

http://msdn.microsoft.com/netframework/

C#

http://msdn.microsoft.com/vcsharp/

ECMA

http://www.ecma-international.org/

Introduction to C# @ ECMA

http://www.ecma-international.org/activities/Languages/Introduction%20to%20Csharp.pdf

Common Language Infrastructure @ ECMA

http://www.ecma-international.org/activities/Lanquages/ECMA%20CL1%20Presentation.pdf

Using ADO.net

http://msdn.microsoft.com/netframework/using/understanding/data/default.aspx?pull=/library/

en-us/dndotnet/html/usingadonet.asp

ASP.net

http://www.asp.net

Winforms
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http://www.windowsforms.net/

Laboratoério .net do ISEP/IPP

http://www.dei.isep.ipp.pt/labdotnet/

Open CLI

http://sourceforge.net/projects/ocl

Mono (.net @ Unix)

http://www.go-mono.com/
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